Skit-PIC Station3

Mulfl-processor starter kit
for PIC microconftroller

Kit content :

e PIC Station-3 experiment board
(includes PICTOF222 module x2, PIC12F683, PICT16F648 and PIC16F887)

e PX-200 programmer

e USB cable

e CX-232 Serial port cable

e DC adaptor

e 16x2 LCD module with cable
e Wire jumper set

e CD-ROM and Technical leaflet
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PIC Station-3 Multi-processor experiment board
for PIC microcontroller technical brief

This is the latest generation of INEX's PIC microconftroller experiment kit. PIC Station-
3 supports lots of PIC microconfroler package and all can work in same time. No need
swap the chip in each socket. It means experimenters could be learn and develop the
multi-processor system in only one experiment platform.

PIC Station- 3 experiment board and also the necessary experimental components.
It was designed to allow students or engineers to easily exercise and explore the capabilities
of the PI C microcontrollers.

Microcontroller port female header

Socket for 18-pin
PIC microcontroller

DC input adaptor jack Socket for 40-pin (MCU-2)
(+9 to +16Vdc) PIC microcontroller

with polarity (MCU-3) RESET switch
protection circuit

ICD2/ICSP modular jack
for conncting In-system
programmer

RUN/PROG switch

POWER switch
— RUN/PROG indicator

6-pin femalke header for

+5V I
power supply PIC10F222 module

Socket for 8/14/20-pin
PIC microcontroller
(MCU-1) shared with 6-
pin header above

8-LED monitor
(active with logic HIGH)

2 of RS-232 port
interface

= +5V supply voltage header

...... Ground header

Piezo speaker 4-button switch LCD module connector
circuit with pull-up resistor
(active low)

0 to 5V variable voltage source for ADC.

Figure 1 : PIC Station-3 experiment board layout
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PIC Station -3 supports all popular software development tools such as Microchip's
MPLAB IDE, CCS C compiler, MikroBasic, MikroPascal, MikroC etc. The CD-ROM contains
MPLAB IDE, some the limit version of popular Basic and C compiler. Figure 1 shows the
layout of PIC Station-3 board.

PIC Station-3 also requires the external In-system programmer board. We suggest to
PX-200 or PX-700 USB In-System Programmer board. However INEX set the special starter kit;
Skit-PIC Station3. This startetr kit is bundled the PIC Station-3 board and PX-200 programmer
and numbers of accessories such as LCD module with cable, Serial LCD module, Wire
jumpers, DC adaptor.

PIC Station-3 technical features

Microcontroller section

e 3 of PIC microcontroller main sockets for supporting the different package of PIC
micrconftroller. It includes :

- 40-pin socket that inserted PIC16F887 chip. Also, you can change to any 40-
pin DIP of PIC16f/18F microconftroller

-18-pin socket that inserted PIC16F648 chip. Also, you can change to any 18-
pin DIP of PIC16F/18F microcontroller

- 20-pin socket; you can change to any 8/14/20-pin DIP of PIC16F/18F
microcontroller and special bonus; the 6 pin female header for supporting the PICT10F222
module - bundled with this experiment board (must use only one package in a time)

® Each microcontroller socket has ICD2 jack for supporting the In-system
programming (PX-200 or PX-700 USB programmer is recommended). You can program and
run all 3 sockets in same time. No need to change |

® Fixed 20MHz crystal clock for 40-pin microcontroller and 4MHz crystal for 18-pin PIC
microconftroller

® Free clock source selection for 20-pin PIC microcontroller socket
® Prepare all I/O port of PIC microcontroller in each socket

® Direct downloading via ICD2 jack by Microchip’s PicKit-2 software. It can operate
with WindowsXP and Vista. You can set the full option of configuration bits for each
microconftroller

® One mode switch for program and run in each microconftroller socket with Mode
LED indicators.

® Support the multi-processor experiments and applications.
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Experiment tools :

e +5Vdc supply voltage

® 8-LED are active with logic *1”

® LCD connector support 16x2 LCD up to 20x4 LCD

® 4 of push-button switches with pull-up resistor

® 2 of RS-232 serial port interfacing circuits

® Pulse generator 1Hz, 10Hz, 100Hz and 1kHz with LED indicators

® 4 of 0 to +5V Variable voltage sources for A/D converter experiment
® Freely Piezo speaker

® Mini-breadboard 4.5 x 3.5 cm. 170 points

® 187 soldering pads prototyping area

PIC Station-3 circuit description

Figrue 2 shows the microcontroller circuit section 1. It supports PIC devices in 10F
series and 8/14/20-pin PIC12F/16F/18F devices. The é-pin female header; MCU-0 supports
PICT10F2x2 module (bundled PIC10F222 with PIC Station-3). The MCU-1 socket supports
PIC12F/16F and 18F in 8/14/20-pin DIP package. You must select to use only one socket in
same fime between MCU-0 and MCU-1. Because all ports are shared. Figure 2-3 illustrares
PIC devices installation of MCU-1 socket for PIC Station-3 board.

MCU-1
8/14/20-pin
+5V
c1
+5V 0.1/50V
1
O Voo
_040 ol F Vss sK1
510 1 8/14/20pin
K1 Lo L 18 RA2
ICD PGC/GP1/RA1
¢ o
RA4
O 19
—o‘c PGD/GPO/RAO
RC5
RC4
(o) RC3
o‘o RC6
RC7
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SW1 RB6
+5V
PGM #1 RBS
© RB4
10k R3 RC2
AAZAOA 41— RC1
g vy MCLR/Vpp RCO
SW2
RESET
i GPAOHO] = (e
= GNDHO 0] O+5V
— GPADO] [0
MCU-0
6-PIN : PIC10Fxx

Figure 2 : Schematic diagram of microcontroller sction 1. It supports MCU-0
and MCU-1 socket
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8-pin DIP 14-pin DIP 20-pin DIP

Figure 3 : Installation devices on MCU-1 socket of PIC Station-3 experiment
board
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Figure 4 : Schematic diagram of microcontroller section 2. It supports 18-pin
DIP package
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Downloading code is operated via ICD or ICSP modular jack. PX-200 or PX-700
programmer is recommended. The mode switch is availabled on the PIC Station-3 boatd
for choosing RUN and PROGRAM mode with LED indicators.

All microconttroller port are connected to female header pin directly. Experimenters
can connect all port to test and experiment fully. Also support all oscillator modes. You
can solder the optional oscillator devices such as crytal, capacitors and resistors for suitable
osciilator circuit.

Figrue 4 shows the microcontroller circuit section 2. It supports PIC devices in 18-pin
DIP package. The recommended device is PIC16F648 and PIC16F88.
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Figure 5 : Schematic diagram of microcontroller section 3. It supports 40-pin
DIP package
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Figure 5 shows the microcontroller circuit section 3. It supports PIC devices in 40-pin
DIP package. The bundled device is PIC16F887. Downloading code is operated via ICD
orICSP modular jack. The mode switch is availabled on the PIC Station-3 boatd for choosing
RUN and PROGRAM mode with LED indicators. We choose the 20MHz clock circuit for this
microcontroller circuit. The oscillator configuration must select to HS type.

The experiment compoments on PIC Station-3 board includes :

1. 8-LED monitos : Active with logic HIGH. The limit-current resisitrors are connected
ready.

4
D7 |00 LED108
D6 |00 LED107
D5 |00 LED106
D4 |00 LED105
D3 |00 LED104
D2 |oO LED103
D1 |00 LED102
DO | oo LED101

R101 =
390*8

2. LCD module interface : At this connector can connect with 16-characters 2-lines
LCD module that bundle in experiment board set. It prepare variable resisitor for LCD's
contrast adjustment.

VR201 +5V
10k K201
57loo |:C t UIC-LCD
Dé6|oo = 1o od’s
D5loo RW 5 ol E
D400 E-O oL
RS|o0C D4 O O D5
R/W|oo D] 5 51D
GND O-O-:L
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3. 4-button switch input : Switch is the type of input device for microcontroller
experiment. Four normally-open push-button switches are made available via connectors.
The buttons switches are wired in an active-low configuration, with an pull-up resistor.

R301-R304 +5V
4.7k x4

S304
SW3 mullam

O 0O|+5v
S303
SW2 mllem OO|D3

e¢—O O OO0O|D2

S302 ® O0|D1
SW1 smllem

S e—10o0|DO0
S$301 P301
SWO sl SWITCH

4.The 0 to +5V Reference Voltage Source: For support analog experiment, PIC
Station-3 board provides 4 channels of 0 to 5V analog voltage source to supply analog
voltage for ADC circuit purpose only.

VR404  VR403 VR402  VR401
10k 10k 10k 10k +5V

R404 R403 R402 R401
1k 1k 1k 1k

28 (o8] [s8] 38

P404 P403 P402 P401
v3 v2 vi Vo
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5. Piezo speaker circuit : Sounding device on this experiment board is Piezo speaker.
It connects with 10mF electrolytic capacitor in series to coupling only signal to speaker.
The piezospeaker has resonance frequency at 2 to 3 kHz. If the resonance frequecncy
apply to the piezo speaker, it lounds maximum. The amplifier device is BC547 fransistor.

SP501
Speaker 32Q

C501 =

10/50V ‘T‘
58

P501
PIEZO

6. RS$-232 circuit : RS-232 serial port interface to microconftroller, This experiment board
provides 2 of interfacing circuits. The schematic diagram is shown below.

C601  +5V
10/50V
T o
= |-|] 10/50V
2 16
4 1 10750V
1601
ceod L | vaos [, &=
10/50V == 5 3T~
11 14 2]1% 0
™@2(00 o 31° o K5
o 0| Rs-232#2
12 4 i3 od
g3 ke
UART#2 TN
10 7 ] e
T™*199 o 310 o K6
,—-0 o| Rs-232#1
RX1 gg 2o > -g o
T e L
UART#1 lE -
C605
= 10/50V

7. Solderless Breadboard : Most experiments willinvolve components placed in the
solderless breadboard. The breadboard on this experiment board size is 4.5 x 3.5cm. 170
point-contacts.



Skit-PIC Station 3 documentation e 11

PIC10F222 in 6-pin SOT23 package

GPO/ICSPDAT GP3/MCLR/Vpp

Vss VDD

GP1/ICSPCLK . GP2/TOCKI/FOSC4

Figure 6 : The PIC10F222 microcontroller module of PIC Station-3 board

PIC10F222 microcontroller module

Figure 6 shows the detaiils and pin assignment of PIC10F222 module that work with
PIC Station-3 experiment board.

Using the PIC10F222 microcontroller module is very easy. Plug it on the MCU-0 female
header on PIC Station-3 borad. The connection pin is assigned following the figure 7. When
construct the experiment circuit, must careful about pin position and MCU-1 socket must
no any device. This is highly recommended when you experiment with PIC10F222.

Connect with PX-200
programmer

RUN/PROGRAM mode switch
RUN : Green LED on ——>u
PROGRAM : Red LED on

\/

Rissr @ O
. PGM  RUN
Plug the PIC10F222 n oo~ Jo| MCU-0
module to 6-pin »o| g [o| P10
header at MCU-0 O[10Fxx|O
Pin | PIC10F222 eadera
name port name — —
— PIC10F2f22 — [Eo (o) |O| Vss
connection pin for O] [e] (0]| 0| GPAO
GPAO GPO/ANO experiment 0[] (o]|0| GPAL
ol le) (o101 GPA2
GPA1 GP1/AN1 = O[RCO
] 0| rc1
GPA2 GP2/TOCKI No any devickes O] [O|rC2
at MCU-1 socket O O|RB4
MCLR GP3/MCLR o o Res
O] [O|rB6
8/14/20 PIN MCU-1

Figure 7 : Using the port connector of PIC10F222 module on PIC Station-3
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Introducing the PX-200 programmer

The PX-200 Microcontroller Programmer is a low-cost development programmer. It is
capable of programming most of Microchip’s Flash microcontrollers. Itis OEM from PICkit2
programmer from Microchip. For specific products supported, see the Iatest information
at Microchip website www.microchip.com.

The PX-200 Microcontroller Programmer Operating System (firmware) can be easily
upgraded from the programming software. New device support can be added by
updating the operating system. The latest firmware is available on Microchip's web site at
Www.microchip.com.

The PX-200 Microcontroller Programmer overview is shown in Figure 8.

USB connector

Optional Serial EEPROMs
(supports more features
in the future)

Main firmware
(upgradable)

Power Supply indicator

Target supply voltage
indicator

Busy indicator

ICSP J

connection PROGRAM switch;

press for programming
the chip via hardware

ICD2 jack pin assignment

Figure 8 : The overview of PX-200 the In-Circuit Serial Programmer for PIC/
dsPIC microcontroller via USB port
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PX-200 Programmer and ICSP

The PX-200 Microcontroller Programmer can program PICmicro® microconftrollers
that are installed in an application circuit using In-Circuit Serial Programming™ (ICSP™). In-
Circuit Serial Programming (ICSP) requires five signals:

e Vpp — Programming Voltage; when applied, the device goes into
Programming mode.

e ICSPCLK or PGC - Programming Clock; a unidirectional synchronous serial
clock line from the programmer to the target.

e ICSPDAT or PGD - Programming Data; a bidirectional synchronous serial
data line.

e Vpp — Power Supply positive voltage.
e Vss — Power Supply ground reference.

However, the application circuit must be designed to allow all the programming
signals o be connected to the PICmicro device without distorting the programming signals.

ICD2 cable assignment

The PX-200 Microconftroller Programmer comes with an ICD2 cable for connecting
between the PX-200 programmer and the target board, the microcontroller. The wire
assignment of this cable is shown below.

ICD2 jack ICD2 cable  PIC/dsPIC microcontroller target board
n n
PGM]| O 22 PGM O
0l 05t ::: - 6 N e | I
vdd OO vop 22 | vdd ?O Vop
u o T
PX-200 Programmer side oo PaM PGM——
———= pGD PGD—— ICD2 jack pin assignment
22 vgg i vid 2= on target board
Vpp Top view Vop g

How to develop PIC microcontroller programming with PIC
Station-3
(1) Install all development software tools. Includes MPLAB V8 or higher and HI-TECH

C compiler Lite mode.

(2) Use the PIC Station-3 board with Microchip’s ICD2 or INEX's PX-200/PX-700 USB
programmer.

(3) Construct the experiment circuit on breadboard of PIC Station-3 board.

(4) Create the C project file and source file on MPLAB. Compile the experiment
project to get the HEX file for downloading to PIC devices.
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(5) Connect PX-200 or PX-700 programmer with PIC Station-3 board.

L f# Connect with ICD cable

Connect with

USB port : Press to select PROGRAM mode
3 (red indicator on)

(6) Apply the supply voltage to the experiment board. Select mode swtich to
PROGRAM. Download the HEX file to microconftroller. After that, change mode switch to
RUN for testing the operation.

INNOVATIVE EXPERIMENT
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Introduction to software development tools

We recommend the use of the free software tools from Microchip (www.microchip.com)
for the development of the C programming language for PIC10F222 microcontroller.Developers
must register before downloading this software at www.microchip.com

The tool set for developing the STM32 microconftroller includes 3 main softwares as
follows :

1. MPLAB IDE : MPLAB Integrated Development Environment (IDE) is a free,
integrated toolset for the development of embedded applications employing Microchip's
PIC and dsPIC microcontrollers. MPLAB IDE runs as a 32-bit application on Microsoft Windows
is easy to use and includes a host of free software components for fast application
development and super-charged debugging. MPLAB IDE also serves as a single, unified
graphical user interface for additional Microchip and third party software and hardware
developmenttools. Moving between tools is a snap, and upgrading from the free software
simulator to hardware debug and programming tools is done in a flash because MPLAB
IDE has the same user interface for all tools.

2. HI-TECH C Compiler PRO for PIC10/12/16 in Lite mode : HI-TECH C compiler
forPIC10/12/16 MCUs implements the optimizations of Omniscient Code Generation (OCG)
- awhole-program compilation technology - to provide denser code and better performance
for development on PIC10/12/16 MCUs. HI-TECH Software has provided this freeware
compiler, HI-TECH C Comepiler for PIC10/12/16 MCUs (Lite mode), as a low-cost tool for
hobbyists and students, however the license allows its use for commercial purposes as
well. Itisideal as a teaching tool for an introductioninto the ‘C’ language and embedded
programming on a PIC10/12/16 MCUs device. Upgrading to PRO mode, contact
www.htsoft.com or www.microchip.com.

3. PICkit2 programming software : It is downloader software from Microchip.
A user can download this free of charge at www.microchip.com. This tool requires the
HEX file from C compiler and download to the flash memory of PIC microconftroller via
ICSP (In-Circuit Serial Programmer).

Al | software tools are bundled together with the e board in a CD-ROM.
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MPLAB IDE and HI-TECH C Compiler installtion

(1) Download the MPLAB IDE installation file from www.microchip.com. Get the
MPLAB_IDE_8_33.zip (The number of version may vary) or from CD-ROM which is bundled
with the PIC Station-3 board. Extract this file fo your computer.

(2) Double click file Setup.exe to start the installation. You meet the Welcome
window. Click on the Next button to License agreement window. Choose | accept the
terms of the license agreement box following click on the Next button.
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(3) Setup type window appears. Choose the installtion type to Complete and click
on the Next button to Choose the destination location window. The default location is
C:\Program Files\ Microchip. We recommended to use defaulf location. Click on the Next

button.
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(4) In the current, MPLAB IDE has many development tools add-in. Developer must

accept dll License agreement,
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(5) After that, the installation start and wait for installtion to complete.
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(6) After that, the HI-TECH C compiler installtion dialogue box appears to ask the
installtion. Click on the Yes button.

e

Question

2 The HI-TECH C installer is in an external executable,
1-/ 1t is not controlled by this installer,
' 1t will nat be uninstalled if wou uninstall MPLAE IDE,
Do you wank bo run the HI-TECH C installer now? IF not, wou can find it at
C:iProgram FilesiMicrochipiHCPIC-pro-9.65.exe

I WEs [}\J [ L]

(7) HI-TECH C Compiler installtion window appears. Click on the Next button.
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(8) The License agreement window appears. It inform the version of compiler as
Free HI-TECH C PRO for PIC10/12/16. Click on the Next button.
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(?) Installation start. Wait for installtion to complete.

PICkit2 Programming software installtion

(1) Download the installation file from www.microchip.com. Get the PICkit 2 v2.61.00
Setup A.zip (number of verion may vary) or from CD-ROM which is bundled with the JX-
PIC100 experiment board. Extract this zip file fo your computer.

(2) Double click file setup.exe in PICkit 2 v2.61.00 Setup A folder to start the installation.
Click on the Next button to accept every installtion steps until the installation is completed.
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C programming developement for
PIC micrcontroller

After install all software tools ready, this chapter explain about how to develop C
programming for PIC10F222 by using HI-TECH C Compiler and MPLAB IDE. The first example
is LED blinking at GP2 pin of PIC10F222.

Developing steps

(1) Open MPLAB and select menu Project > Project Wizard. The Welcome window
appears. Click on the Next button.

¥4 MPLAB IDE v8.33

File Edit ‘Yew Project Debugger Programmer  Tools

- welenrr e

D ~u Praoject ﬂizard. o This v ze-z -olee wo Zimsbs o0 gzl e 2w ML UG
D‘ % prosck
Untitle X 2.
— Qpen...
Close k
Set Active Project 4

Cuickbuild {no L asm File)

Tocc wres Zies dad,

Build Configuration b
Build Ootions. .. »

[ o ! T

(2) Choose device number as PIC10F222. Click on the Next button.
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(3) Seelect compiler tools as HI-TECH Universal ToolSuite. Click on the Next button.
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(4) Define the target folder and project. Click on the Browse button to defiene the target
folder and project. In this example define to LEDBIlink. Affer that, click on the Next button.
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(5) The Add exist files window appears. Not add any file now. Click on the Next

button to next step.

| Propct Wized

E

Slap ko
AR gl poa,

=0 Wi Ire T -
=-[71 Avm-reeF -h1Fie
=77 e G Tawer
1 4= 2E €12
[ e TR TR
[y R AT TN
= I_TI BT
wH_ e
B sprore st
& “C0Zd o Zavanem
[T 1 R W iy
S TR AT Ea s
F = 3

Mlare~com

,\rﬂ:_!-'

i
=

E

* B




Skit-PIC Station 3 documentation e 21

(6) Summary window appears to report all information of the developed project
file. Click on the Finish button.
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(7) The main window of MPLAB is opened. Select menu File > New. The editor window
is appeared and create the new source code. Type the code following the Listing 1.

Ti= L a2 opmc:

L=scqs  bracramirer  lzob worigores Gercoe ke

LS iwE SAEAN T vebug [v]= mhd B BB Checksum: Oxcc20
LEDE I nk micw: i |

= 1 LECHlimhamu
i. .:I tamze gm=E
U Tl Hood = o
¢ Elis. Fles
E‘ -__'l [y
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stput il
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#include <htc.h>

#define XTAL FREQ 4000000

__CONFIG (OSC_4MHZ &§MCPUEN&WDTDIS&UNPROTECT&MCLRDIS) ;
void main () {

OPTION=~TOCS; // Clear bit TOCS GP2=Digital IO
TRIS=0b11111011; // Set Only bit GP2=0OUTPUT
while (1) {

GP2=1; // LED ON

__delay ms(197); // Maximum Delay in milisecond

GP2=0; // LED OFF

__delay ms (197);

Listing 1 : Example C code for getting start the PIC10F222 programming
development with MPLAB and HI-TECH C compiler

(8) Save file as LEDBIink.C (must define .C extension) to same folder of project file.

(?) Select to menu Project > Add Files to Project.... Next, select LEDBIink.C file to
add with target project file.

Project  Debugger  Programmer  Tools  Confi

Project Wizard. ..

Mew. ..

open...

Close 4
Set Active Project 4

Package in .zip

Clean

Build F10

Reebuild Chrl+F10
HI-TECH C Manual F11

Build Configuration 4
Build Options. .. 3

Save Project

Save Praject as...

Add Files ko Project. ..

Add Mew File ko Project. .. %

Remove File From Project 4
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(10) Compile the project file by selecting menu Project - Build All or click on the
B button.

Project  Debugger  Programmer  Tools  Conl

Project Wizard. .,

Mew. ..

Qopen...

Close r
Set Active Project 4

Package in .zip

Clean

Biuild F10

Rebuild % Chrl+F10
HI-TECH C Manual Fi1

Build Configuration r
Build Options. .. *

(11) Compilation result reports at Build window. After compilation is completed,
the completed message ********** Byild successfull ******+** will be appeared on last line
of Build window.

Build " ergion Contral || Find in Files | PICKit 2

Funning this compiler in PRO mode, with Omniscient Code Generation enabled.
produces code which is typically 5222 smaller than in Lite mode.

The HFTECH C FRO compiler output far this code could be 13 words smaller.
See hitp:/fmicrochip hfsoft comfportal/pic_pro for more infarmation.

Loaded DiWWorkZ0094FIC STATION 3 CODEYCode\LEDBlink!, LEDBlink.cof.

pesssssess Build successfull

If there is error, you must back to edit and correct already first.

(12) The HEX file; LEDblink.hex is created and located to same project folder. Next,
use this HEX file to download to PIC10F222 microcontroller on the PIC Station-3 board.
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4.2 Downloading code
In this example explain about how to downloading the HEX file to PIC Station-3
board with PX-200 progemmer by using MPLAB IDE.
(1) PLug the PIC10F222 module on the MCU-0 female header of PIC Station-3 board.
(2) Connect the PX-200 programmer board with computer’s USB port.

(3) Connect the PX-200 board with PIC Station-3 at K1 jack. Press MODE switch to
PROGRAM mode. The mode indicator is red.

(4) At MPLAB IDE, select menu Programmer > PICKit 2

Programmer  Tools Caonfigure  Window  Help

Select Programmer  # Maone
L PICSTART Plus

Program 2 MPLAEB ICD 2

Fead -

eriy 4 PICkit 3

Erase 2 MPLAE ICD 3

Blank Check B AMSS1 Quick Programmer Beta
w 7 PICkE 2

Conneck G MPLAE PM 3 %

Dawrlnad 05 QREAL ICE

10 PRO MATE II
Release from Reset

Hrld in Pecst

(5) At menu Programmer, the command as Program, Read, Verify, Erase and
Blank Check are enabled in Programmer menu.

Programmer Tools  Con

Select Programmer ¥

Progran
Read
Werify

Erase

Elank Check,

Conneck
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The Programmer command icons are appeared at the top of MPLAB menu

icon too.
D D R

(6) Select command Program or click on the B to download the current HEX file
from compilation to PIC10F222. Tab PICkit 2 of Output window shows all steps of
programming following the picture below.

Dutput i

Build | Version Contral | Find in Files  FICKit2 |

FProgramming Target (15/9/2551 13:52:07)
Erasing Target

Frogramming Program hemony (0x0 - 0x31)
"erifying Program bMemony (0x0 - 0x31)
Frogramming Configuration Memory
“erifying Configuration Memaory

FICkit 2 Ready

=l

However you can use PICkit 2 programmign software to downlaod the HEX file to
PIC microcontroller on PIC Station-3 board. See all instructions at PX-200 documentation.
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Preparing the PIC10F222 module for PIC Station-3 experiment
board

Plug the PIC10F222 microcontroller module to 6-pin female header at MCU-0. The
connection pin is assigned following the figure 9. When construct the experiment circuit,
must careful about pin position and MCU-1 socket must no any device. This is highly
recommended when you experiment with PIC10F222.

Press the MODE switch. The switch's shaft will down and red LED of PGM. mode is
turned on. Now the board ready for programming. After downlaoding the HEX file, cheange
mode to RUN by pressing the MODE switch again. The switch's shaft releases and green
LED of RUN is turned on instead. PIC10F222 run the downloaded code.

Testing

(1) Construct the circuit following the figure 10 on the PIC Statfion-3 board.
(2) After downlaoding the HEX file , select the mode to run mode.
(3) Observe the LED at GP2 pin operation.

LED blinks with 0.2 second rating.

Connect with PX-200
programmer

RUN/PROGRAM mode switch
RUN : Green LED on ——Fu
PROGRAM : Red LED on

Y

Resstr @ O
%] PGM RUN
.'.
Plug the PIC10F222 oo~ o MCU-0
module to 6-pin »o| o] P
header at MCU-0 O|10Fxx|©
Pin PIC10F222
name port nhame — —
— PIC10F2f22 — [Eo (o) |O| Vss
connection pin for O] [e] (01| 0| GPAO
GPAO GPO/ANO experiment @lo M5l cras
olle o100l gPA2
GPA1 GP1/AN1 & SJI0[RCo
O (oY (O] ret
GPA2 GP2/TOCKI No any devickes ol o lEIv
at MCU-1 socket O [o)|O| rB4
MCLR GP3/MCLR ol o|mHe
=] =] |0 RB6
8/14/20 PIN MCU-1

Figure 9 : Using the port connector of PIC10F222 module on PIC Station-3
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To

+5V
o]
VDD 1
GPO/ANOH—0
GP3MOR GPU/ANIfE—o Ri
390R
GP2/ToCLKI |4
PIC10F222 LED1

Vss
2

RS-232 Interface

RS-232 #2

RS-232 #1

RD2
40 PIN MCU-3

RUN

18 PIN

o

=

MCU-0
PIC10Fx

PIC Station

Microcontroller board 3
654321
[ XoT ) (o ] ] ] ] =] =] =]
monrTor [O[0[O[0[0[o|o]

D7 D6 D5 D4 D3

v3 V2 Vi Vo
55 B3 B 3
o[o] [Blo] ool oo

0-5v 0-5v 0-5v 0-5v

X2 RX2
i
[o[o] [B[o]

X1 RX1

IN INPUT SW. active low
-
PIEZO SPEAKER SW3  SW2  SW1  SWO

LCD-cont.

K7-LCD

4-bit mode

VoD (O] [e] (o] (01| Vss
RA1 GPAs O] [e] (o](0] GPAO
RAO GPA4 (O] =] ][0 GPAL
RA7 MCLR [O] [} o1 51| GPA2
RA6 RC5 [O][C] o] (0| RCO
VDD RC4|0 ]| 0| RC1
RB7 R[] o] O| RC2
RB6 A il o 5[0 RB4
RB5 od[s]| © [](O] RBS
RB4, RrB7 [O][e] (c](O] RB6
71CU-2  [8/14/20 PIN MCU-1
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0000000000000 000O0
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Figure 10 : The example testing circuit for PIC10F222

INNOVATIVE EXPERIMENT










